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Introduction
Perceptions allows you to calculate taxes on sales transactions. Taxes are calculated 
for a specified date range or based on a reduction in the tax percentage. You can also 
regenerate the taxes for any modifications in the taxable amount and date ranges. 
You can also generate the files to be sent to the tax authorities.

Perceptions also integrates with Analytical Accounting to provide you with 
detailed analysis information for taxes that are regenerated for sales transactions.

Check for current instructions
This information was current as of March 2008. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=79222) for the most current 
documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Perceptions, and how it integrates with the Microsoft Dynamics™ GP 
system.

To make best use of Perceptions, you should be familiar with systemwide features 
described in the System User’s Guide, the System Setup Guide, and the System 
Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Setup,” describes how to set up Perceptions so that it meets the 
needs of your business and integrates with the other modules you use. 

• Chapter 2, “Reports,” describes the process regenerating taxes and printing the 
reduction reports for customers.

http://go.microsoft.com/fwlink/?LinkID=79222
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within 
Microsoft Dynamics GP. Additional tutorials are available through the 
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.
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U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you 
select an option, the process to install the updates will begin immediately.

Check with your system administrator before installing tax updates. To be sure that tax 
updates are installed correctly, refer to documentation for specific tax updates on the 
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
Use this information to set up a reduction in the percentage of taxes for a customer 
or an agent. You can also change the tax percentage specified in the Tax Detail 
Maintenance window for an agent.

This information is divided into the following sections:

• Setting up reduction/change percentage for an agent
• Setting up reduction percentage for a customer
• Adding a tax detail to a tax schedule
• Excluding documents from tax calculations
• Activating the minimum set up amount for tax calculations

Setting up reduction/change percentage for an agent

Use the Agent’s Aliquot Reductions/Change Setup window to set up the 
reduction/change in tax percentage for an agent. 

To set up a reduction/change percentage for an agent:
1. Open the Agent’s Aliquot Reductions/Change Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Tax 
Details >> Select a sales type tax detail ID >> Additional >> Agent’s Reductions 
Setup)

2. The Tax Details field displays the tax detail ID selected in the Tax Detail 
Maintenance window.

3. Enter a date range to calculate reductions/change for the selected tax detail ID 
in the Date From and Due Date fields.

4. Select the type of operation you want to perform on the selected tax detail ID.

Reduction Select this option to calculate reductions.

Change Select this option to modify the tax percentage specified in the Tax 
Detail Maintenance window.
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5. Enter the reduction percentage in the % field.

The percentage you enter here will override the percentage set up in the Tax Detail 
Maintenance window for the specified date range.

6. Enter the Agency name.

7. Mark the C.E checkbox to print a certificate for the selected tax detail ID.

8. Choose Save to save the reduction/change percentage and Clear to clear the 
values displayed in the window. 

9. Choose a line in the scrolling window and choose Select to modify the values 
you’ve entered.

10. Choose Item Options and Choose View All to display the reduction/change 
details in the scrolling window.

11. Choose Delete to delete the selected line in the scrolling window.

12. Choose Close to close the window without saving the changes you’ve made.

Setting up reduction percentage for a customer

Use the Subject’s Aliquot Reductions Setup window to set up a reduction in 
percentage of taxes for a specific customer. Reduction is calculated on the total 
taxable amount.

To set up a reduction percentage for a customer:
1. Open the Subject’s Aliquot Reductions Setup window.

(Cards >> Sales >> Customer >> Select a Customer ID >> Address button >> 
Additional >> Subject Reduction Setup)

2. The Client Code and the Address Code fields display the Customer ID and the 
Address ID from the Customer Maintenance window.

3. Select a tax detail ID.
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4. Enter a date range to calculate reductions for the selected tax detail ID in the 
Date From and Due Date fields.

5. Enter the reduction percentage in the % field.

This reduction percentage is valid for transactions for the selected tax detail ID only 
during the specified date range. The tax percentage set up in the Tax Detail 
Maintenance window will be considered for transactions beyond the specified date 
range.

6. Enter the name of the Agency that collects the taxes.

7. Mark the C.E checkbox to print a certificate for the selected tax detail ID.

8. Choose Save to save the reduction percentage you’ve set up.

9. Choose Item Options and Choose View All to display the reduction/change 
details for the selected customer in the scrolling window.

10. Choose Clear to clear the values displayed in the window.

11. Choose a line in the scrolling window and choose Select to make the line 
available.

12. Choose Delete to delete the reduction/change percentage you’ve set up for the 
selected tax detail ID.

13. Choose Close to close the window without saving the changes you’ve made.

Adding a tax detail to a tax schedule

Use the Tax Details / Tax Plans window to add a tax detail to all the applicable tax 
schedules set up in Microsoft Dynamics GP. Before you begin, you must have 
already set up all the tax detail IDs you'll require in the Microsoft Dynamics GP Tax 
Detail Maintenance window. Refer to the Microsoft Dynamics GP manual for 
information on setting up tax detail IDs and tax schedules.
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To add a tax detail to a tax schedule:
1. Open the Tax Details / Tax Plan window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Tax 
details >> Select a sales type tax detail ID >> Additional >> Tax Detail Plan)

2. The tax detail ID field displays the tax detail ID from the Tax Detail 
Maintenance window. You can also select a different tax detail ID to assign it to 
a tax schedule.

3. The description field displays the description for the selected tax detail ID.

4. Select a tax schedule ID from the Available Tax Schedule IDs list and choose 
Insert to add it into the Selected Tax Schedule IDs list. You can insert multiple 
tax schedule IDs here.

5. Choose Remove to remove the selected ID from the Selected Tax Schedule IDs 
list.

6. Choose the Close icon to save your changes and close the window.

Excluding documents from tax calculations

Use the Exclusion of Documents window to exclude document types from tax 
calculations. The document types having the selected tax detail ID attached will be 
excluded from tax calculations.
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To exclude documents from tax calculations:
1. Open the Exclusion of documents window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Tax 
details >> Select a sales type tax detail ID >> Additional >> Exclusion of 
documents)

2. The Tax Details column displays the tax detail ID from the Tax Detail 
Maintenance window. 

3. Select a module type whether Receivables Management or Sales Order 
Processing to exclude a document type.

4. Select the document type you want to exclude from tax calculations. All the 
documents of the selected document type, and having the selected tax detail ID 
attached, will be excluded from tax calculations.

5. Choose Save to display the document to be excluded in the scrolling window. 

6. Select a line in the scrolling window and choose Select to make the line 
available for modification.

7. Choose Delete to delete the selected line from the scrolling window.

8. Choose Close to close the window without saving your changes.

Activating the minimum set up amount for tax 
calculations

Use the Minimum Setup window to consider the minimum taxable amount 
specified in the Tax Detail Maintenance window for the selected tax detail ID while 
calculating taxes. Taxes will be calculated only if the cumulative invoice total for the 
selected tax detail ID is more than the minimum amount specified. 
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To activate the minimum set up amount for tax 
calculations:
1. Open the Minimum Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Tax 
details >> Select a sales type tax detail ID >> Additional >> Minimum Setup)

2. The Tax Details field displays the tax detail ID you’ve selected in the Tax Detail 
Maintenance window.

3. Mark the Uses Minimum checkbox to consider the minimum taxable amount in 
the Tax Detail Maintenance window for tax calculations. 

4. Choose Save to save the Setup.

5. Choose Delete to unmark the Uses Minimum checkbox. The cumulative taxable 
amount for the selected tax detail ID will not be considered for tax calculations.

6. Choose Cancel to close the window.
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Chapter 2: Reports
You can calculate and regenerate the taxes before posting the transactions. You can 
also generate the files to be sent to the tax authorities.

This information is divided into the following sections:

• Regenerating taxes
• Printing the reduction report for customers

Regenerating taxes

Use this information to calculate and regenerate the taxes during transaction entry 
or before posting the transactions. Taxes are regenerated for any modifications in 
the taxable amount and the date ranges.

To regenerate taxes:
1. Open the Sales Batch Entry window.

(Transactions >> Sales >> Sales Batches) OR 

Open the Sales Transaction Entry window
(Transactions >> Sales >> Sales Transaction Entry)

2. Select the batch for which you want to regenerate the taxes.

3. Choose Additional >> Tax Regeneration. A message appears indicating that the 
taxes were regenerated successfully.

4. Click OK on the message to return to the Sales Batch Entry window and post 
the transaction.

Printing the reduction report for customers

Use this information to print the tax reduction report for customers.

To print the reduction report for customers:
1. Open the Configuration Report of Aliquot Subject window.

(Cards >> Sales >> Customer >> Select a customer ID >> Address >> 
Additional >> Subject Reduction Setup >> Click the printer icon)

2. Mark the Tax Details checkbox. You can select a tax detail ID for which to print 
the tax reduction report for the selected customer.

3. Mark the Delivered Certificate checkbox to print reports.
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All Select this option to print all the reduction reports for the selected tax 
detail ID.

Range Select this option to print reduction reports for the selected tax detail 
ID for a specified date range.

4. Enter the date range for which to print the report in the Date From and Date To 
fields. These fields are available only if you have selected the Range option.

5. Choose Print to print the reduction report.

6. Choose the Close button to close the window.
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Glossary
Reduction percentage

Reduction in the tax percentage.

Reduction report
Displays the details of reduction in the tax 
percentage for a customer.
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Index
A
Agent’s Aliquot Reductions/Change 

Setup window, displaying 5

C
changes since last release, information 

about 3
Configuration Report of Aliquot Subject 

window, displaying 11
current upgrade information, accessing on 

the Web 3

D
document types, excluding from tax 

calculations 8
documentation, symbols and conventions 

2

E
Exclusion of documents window, 

displaying 9

H
help, displaying 2
Help menu, described 2

I
icons, used in manual 2

L
lessons, accessing 3
lookup window, displaying 3

M
minimum set up amount, activating 9
Minimum Setup window, displaying 10

N
new features, information about 3

O
Orientation training, accessing 3

P
perceptions, introduction 1

R
reduction report for customers, printing 

11
required fields, described 3
resources, documentation 2

S
Subject’s Aliquot Reductions Setup 

window, displaying 6
symbols, used in manual 2

T
tax detail, adding to a tax schedule 7

Tax Details/Tax Plan window, displaying 
8

tax percentage for agent
changing 5
reduction 5

tax percentage for customer, reduction 6
taxes, regenerating 11
tutorial, accessing 3

U
upgrade information, accessing on the 

Web 3

W
what’s new, accessing 3
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